Introduction

**TouchCopy** is designed to help you get the most out of your iPod, iPod Touch, iPhone or iPad.

With TouchCopy you can back up your music to iTunes or your computer. But that's just the beginning, TouchCopy can also copy Apps, Books, Photos, Contacts, SMS messages and just about anything on your iPod or iOS device.

These help pages will guide you through using TouchCopy and point out some of the cool features the program has.

![TouchCopy Interface](image)

**Demo Restrictions**

The demo of TouchCopy has the following restrictions:-

- Will only operate for 15 days.
- Up to 100 downloads and transfers are allowed.
- Copying of non-audio or video content blocked.

All of these restrictions are removed when the demo is registered.
Don’t Steal Music!

TouchCopy is intended to be used in a legal context. It is designed so that you can listen to and copy music you legally own into locations where you are permitted to listen to it. Additionally, TouchCopy acts as a "Disaster Recovery" program, should your main iTunes library become corrupt or is deleted.

YOU ARE NOT PERMITTED TO USE THIS PROGRAM TO COPY MUSIC YOU DO NOT LEGALLY OWN.

See the TouchCopy terms and conditions for more information.

Requirements

TouchCopy 12 works with all models of iPod, iPod Touch, iPhone and iPad.

PC System Requirements

TouchCopy requires a PC running either Windows XP SP2, Windows Vista or Windows 7. Both 32 and 64 bit versions of Windows are supported.

TouchCopy is a .NET application and as such requires the Microsoft .NET Framework Runtime version 4.0 to be installed on your PC. The Framework is installed with Windows 7 and Windows 8 by default. If you are running Windows XP or Windows Vista you can obtain the .NET runtime by using Microsoft Windows Update or by downloading the .NET installer directly from Microsoft.

If you are using an iPod Touch or an iPhone, TouchCopy also requires that iTunes version 10 or higher be installed. You can download iTunes from Apple Inc. For other types of iPods, TouchCopy will work without having iTunes installed.
Copying Music and Video from your iPod or iPhone to iTunes or your computer.

Start with your iPod or iPhone disconnected from your computer and iTunes closed.

1. Download and Install TouchCopy.

2. Start up TouchCopy by double-clicking the TouchCopy icon on your desktop.

3. If the welcome window appears click past it until you get to a window asking to connect your iPod.

4. Connect your iPod to your computer.

TouchCopy may start iTunes - don't worry, TouchCopy has fixed it so that iTunes will not sync music or video with your iPod while TouchCopy is running. These changes are restored when you quit TouchCopy.

Copying Music into iTunes

You can now select which songs you want to copy into iTunes, if you want to select all your music, select "Music" from the list on the left and click on "Copy to iTunes" button in the TouchCopy control bar.

If you want to select a subset of your music collection to copy, browse your music using the Genre, Artist and Album lists and click the "Copy to iTunes" button to transfer your selection over to iTunes.

Note that if you're running the demonstration of TouchCopy you will be limited to 100 copies maximum.

Instructions if you don't have iTunes installed....

Please note that these instructions do not apply for the iPod Touch, iPhone or iPad as iTunes needs to be installed on your computer for TouchCopy to be able to work with these devices.

If you don't have iTunes installed and you own an iPod Classic- you need to set your iPod into "Disk Use Mode". If when starting TouchCopy you get a message indicating that your iPod cannot be found but your iPod is connected it may be that your iPod is not configured for "Disk Use".

You can set your iPod to disk use mode without using iTunes. Follow these instructions...

Make sure your iPod is disconnected from your computer.
Reset your iPod by pressing and holding the center key and Menu key. You need to hold these keys down together for about 5 seconds until your iPod resets.

As your iPod resets the Apple logo appears on the screen, press and hold the center key and Play/Pause key together until a check mark appears on the iPod screen. You can now let go of the iPod keys.

Now connect your iPod to your computer.

**Shutting Down TouchCopy**

When you have finished using TouchCopy, close the TouchCopy window. If iTunes is open, TouchCopy will close iTunes. TouchCopy should then eject your iPod from your computer - unless disk mode was enabled before running it with TouchCopy. In which case you will have to use the normal method of ejecting mounted disk drives from your operating system.

**Handling Audio and Video with TouchCopy.**

TouchCopy can play and copy all the Audio and Video content on your iPod or iOS Device.

**Backup your iPod or iPhone**

TouchCopy lets you copy your music, playlists, podcasts, videos and more to your computer or directly into your iTunes library.

You can select individual items to copy from your iPod or iPhone but you can also backup all the multimedia content in your device in a couple of mouse clicks!

Click the "Backup" button on the TouchCopy Control Panel. The Backup button is only available for registered TouchCopy users. The following window will open...
Select where you want your iPod content to be placed: In a folder on your computer, the location of which is specified in the Options Window, or directly into your existing iTunes library.

Click "Continue" and TouchCopy gets to work. TouchCopy will copy all of the following items to the destination you have specified...

- Music
- Video
- TV Shows
- Podcasts
- Playlists

**Restoring your iTunes library from a backup**

To restore your iTunes library from a backup, open iTunes, select the File tab and then click on Add folder to library. From there navigate to the location on your computer where your backup is stored and click on OK. Wait for iTunes to finish importing your music.

Then, connect your iPod or iPhone and use iTunes to re-sync it which will reload your music to your device.
Playing iPod Music and Video using TouchCopy

TouchCopy can play your music directly off your iPod or iOS device through your computer.

Once you have made your song selections pressing the play button will play all of your selected songs in order. Pressing your space bar also plays / pauses. Alternatively, double-clicking a song in the song list will play that song and any subsequent songs in the list.

The playback progress slider at the top of the window shows you how far through the track TouchCopy has progressed.

Clicking and dragging the Time Tracker will move you backwards or forwards in the track you are playing. The Time Remaining and Time Played values will be updated as you do this to aid you. Releasing the Time Tracker will continue to play the track from that point.

You may continue to browse your music library and perform other operations (i.e. copy / transfer, search) while your music is playing. Pause your playback by hitting the Pause button, resume play by hitting the play button again. You may skip to the next track in your selection by hitting the Next button.

The volume at which the music is played back can be set in TouchCopy Options.

Snap Back arrow in TouchCopy

Like iTunes, TouchCopy enables you snap back to the song currently playing in TouchCopy. If you start playing a track and then continue to browse around your music collection in TouchCopy, the TouchCopy snap back arrow appears.

To snap back to the currently playing song just click on the snap back arrow in TouchCopy. Note that the snap back arrow only appears while a song is playing.
**Music Failing To Play**

Occasionally, a music file on your iPod may not play. Your iPod will skip over such a track until it finds one in the play sequence that it can play. Also, occasionally you may find that none of your DRM protected music will play on your iPod - your iPod will also skip those tracks also.

TouchCopy follows this same behaviour. If TouchCopy detects a track that your iPod will skip playing then it will mark the track with an icon - ![TouchCopy will then skip to the next track.](image)

In order to fix a corrupted music file on your iPod you will have to re-write that file back onto the iPod from iTunes. If your iPod is skipping all your DRM protected music you will need to re-sync your iPod to iTunes once your iTunes has been authorized with your iTunes music store account.

Music that is failing to play in TouchCopy will be added to the TouchCopy "Failed to play" Log. See Error Logs for further details.
Browse your iPod, iPhone or iPad Content

TouchCopy allows you to browse the contents of your iPod, iPhone or iPad with ease.

![Browse your iPod, iPhone or iPad Content](image)

You can navigate your way around your iPod content in a similar way you would with iTunes. Select the type of content you want to view from the source list. i.e. Music, Video, Audiobooks etc. The browse lists and song list content will change to show you only the type of items you have selected. You can narrow down the items in the song list further by making selections in the Genre, Artist and Album lists.

Once you have the selection of items you need in the song list you can play, copy or transfer those items using TouchCopy.

Searching for Music and Video

Press the search button in the TouchCopy control bar and a search box opens. Type in your search string to start your search.

![Search for Music and Video](image)

TouchCopy looks for matches in the Song, Album and Artist names. You can restrict the search to Song Names only by checking the "Search Song Names only" box in the search window.
By default TouchCopy searches in the playlist or source you have selected. You can tell TouchCopy to search all the content it has on the device (music and video in all playlists and sources) by clicking the "Search Everywhere" check box.

**Comparing iPod and iTunes Content**

TouchCopy performs real time comparisons between your iPod and iTunes contents. If a track is currently in your iTunes library, TouchCopy will display a musical note next to that track in TouchCopy. i.e. 🎶.

For a full report of tracks on your iPod that are not in iTunes, use the "Not in iTunes" report.

**Browsing anything other than music and video content**

If you want to view contacts, calendars, photos or notes on your iPod - click the corresponding icon in the TouchCopy Categories List. To return back to the music lists, click the iPod entry in the Categories List.
Copying Your Music and Video To Your Computer

TouchCopy can copy iPod and iPhone songs and videos in any format that your device is capable of playing, including MP3, AAC, WAV, WMV, MP4 etc. TouchCopy does not perform any file conversion on your songs or videos.

You can copy all the music and video on your iPod using the Back Up button in TouchCopy.

You can also copy selections of music. Select the audio or video you wish to copy by browsing or searching your iPod content using TouchCopy.

Once you have selected the items you wish to copy, press the "Copy to PC" button in the TouchCopy Control Bar.

You can then select where on your computer you would like to copy your selected iPod content (see above).

By default will save your music in artist / album subfolders and name the music files as <track number> - <track title>.

You can change the default save location, directory structure and file name format using TouchCopy options.

Copying Playlists to your computer hard drive

To copy a playlist to your computer hard drive select a playlist and click on "Copy to PC" or the "Copy to "Mac" button.

Music in the playlists will be saved to your computer in the folders and file name format you have specified in Options.

For Playlists, TouchCopy also produces an XML file named after the Playlist you are copying. This XML file contains information about the tracks and track order of the Playlist. The XML file can be used to import the playlist into iTunes.
Copy Songs from A Search

If copying songs displayed as a result of a TouchCopy search, you have the option to save the songs as a playlist with the same name of the search text. See Setting Options for more details.

Copy Status

As each track is copied onto your hard drive an icon next to that track indicates whether the copy was successful or not. The icons used are ✓ for success and ❌ for failure.

Tracks that fail to copy will be shown in the "Failed to copy" Error log. See Logs for further details.

As a track is successfully copied, TouchCopy will mark the track on your iPod as copied. Whenever you connect your iPod to TouchCopy - TouchCopy will detect the music you have previously successfully copied. See "Copy History" for more information.

Successfully copied tracks will also show in the "Items Copied" report. See Reports for further details.

Adding Copied Music or Playlists into iTunes

If you have iTunes installed you can add the music you just copied into iTunes. In iTunes, select File->Add folder To Library... from the menu. Select the the folder you just saved your music to and click OK.

If you have copied a playlist, you can import the playlist into iTunes. In iTunes, select File -> Library->Import Playlist... Select the XML file saved by TouchCopy with the same name as the playlist you require and click Open.

Note that you can also transfer music and playlists directly into iTunes. See Transferring Music into iTunes.
Transfer Your Music and Video into iTunes

This functionality is only available if Apple iTunes is installed on your computer.

Copying Music and Video to iTunes

TouchCopy can copy iPod and iPhone songs and videos in any format that your device is capable of playing, including MP3, AAC, WAV, WMV, MP4 etc. TouchCopy does not perform any file conversion on your songs or videos.

Use the TouchCopy Back Up button to copy all your music, video, audio books, podcasts and playlists to your iTunes library.

Alternatively, TouchCopy can perform a comparison between the content on your iPod and the content in your iTunes library and display a list of tracks that have not yet been copied to iTunes. See Reports for more details.

You can also copy just a selection of iPod content. Once you have made a selection in TouchCopy, you can transfer it into your iTunes library by pressing the "Copy to iTunes" button in the TouchCopy Control Bar.

TouchCopy will display the progress of the copy operation in the Control Bar. The status bar at the bottom of TouchCopy will tell you when the transfer is complete.

If transferring songs displayed as a result of a TouchCopy search, you have the option to create a playlist with the same name of the search text. See the Options menu in TouchCopy for more details.

Transferring Playlists to iTunes

To transfer your iPod playlists into iTunes select the Playlists you want from the source list in TouchCopy. You can select multiple playlists by CTRL-Clicking items in this list. Once you have selected your Playlists - click the "Copy to iTunes" button in TouchCopy. When transferring a playlist into iTunes, the songs are transferred and a new playlist of the same name is created. Note that "smart playlists" and "genius playlists" are copied into iTunes as ordinary playlists.

If a track is already in your iTunes main Library, TouchCopy will not create a duplicate of that track in iTunes, it will just add the track to the Playlist.

Transfer Status

As each track is transferred into iTunes an icon next to that track indicates whether the transfer was successful or not. Here are the icons used:

- Track was successfully copied to your iTunes including all the metadata.

- Track was successfully copied to iTunes, however some of the metadata could not be transferred.

- Track could not be copied to iTunes.
Tracks that fail to copy to iTunes will automatically be added to the "Items failed to transfer" Error Log. See Logs for further details.

Tracks that successfully transferred into iTunes will be shown in the "Items Copied" report in TouchCopy. See Reports for further details.
Copy History

As a track is successfully copied, TouchCopy will mark the track on your iPod as copied. Whenever you connect your iPod to TouchCopy - TouchCopy will detect the music you have previously successfully copied. These allows you to keep track of which tracks have been copied and which have not.

Tracks can be marked with one of the following icons...

✅ Track was successfully copied to your iTunes including all the metadata.

✅ Track was successfully copied to iTunes, however some of the metadata could not be transferred.

❌ Track could not be copied to iTunes.

Note that if you previously copied your iPod to your computer hard drive with TouchCopy and now you wish to copy your iPod to iTunes (or the other way around) you should clear the history of copied tracks, as TouchCopy does not differentiate between history of copying to PC or iTunes.

Recopy

If you attempt to copy a track that is already marked as copied, you may see this window...

![Re-copy window]

Here you can specify how you would like to handle previously copied music. You can change this setting at any time using TouchCopy Options. Click Continue to then proceed with the copy or transfer operation.
Clear Copy History

If for some reason you need to copy your iPod again and your selection contains tracks that have previously been copied, TouchCopy enables you to skip tracks already copied or recopy them.

You can clear the history of successfully copied tracks in TouchCopy by clicking on the "Clear History" button on the bottom of the TouchCopy screen.
When TouchCopy has a problem performing an operation on a particular song or video on your iPod, that item is automatically added to an error log.

If the error log does not currently exist - a log is created and added to the source list in TouchCopy under the Logs heading.

The three logs that TouchCopy can create are "Failed Copy to PC", "Failed Copy to iTunes" and "Failed to Play".

Clicking on one of the logs in the TouchCopy source list will display the tracks currently stored in those logs. For example, if three songs failed to copy to iTunes, those three tracks will be displayed when the "Failed Copy To iTunes" log is selected. You can then try and copy those tracks again into iTunes from the log list.

TouchCopy stores Log information on your iPod. This means that TouchCopy can show you which songs are causing problems if you reconnect your iPod to TouchCopy at a later date. The log information is retained when you disconnect your iPod from your computer.

**Clearing Logs**

To remove all log information from your iPod, click the "Clear History" button at the bottom right of the TouchCopy window.

To remove individual logs, select the log you want to remove and then click the "Clear Error Log" button that appears at the top of the song list.

**Saving Logs to File**

You can save a list of the items present in a log to your computer for later reference without TouchCopy. Select the log of interest and then click the "Save Log" button that appears at the top of the song list.
Reports

TouchCopy is able to generate Reports based on your iPod content and copy history to make it easier for you to select which items need to be copied and which do not.

TouchCopy can generate the following reports...

**Items to Be Copied**

Generates a list of songs and video that have not been copied to your computer or iTunes. If songs are selected from this list and then copied, those songs are automatically removed from this report.

**Not in iTunes**

When this report is selected, TouchCopy will analyze what content is in your local iTunes library and compare it against the iPod contents. TouchCopy will present a list of items that are present on your iPod but not in your iTunes library.

This is useful when your iTunes library already contains some of your iPod content but you are not sure what.

You can select the tracks shown in this report and then click "Copy to iTunes". This then copies to iTunes all the missing tracks.

**Items Copied**

Generates a list of songs that have either been copied to your computer or transferred into iTunes.

**Refreshing Report Contents**

To re-generate the report currently being viewed, click "Refresh Report" at the top of the song list.

**Clearing Reports**

To remove all reports from your iPod, click the "Clear History" button at the bottom right hand side of the TouchCopy window.
Viewing and Copying Photos

TouchCopy lets you browse and copy photos on your iPod or iOS device to your computer or set a photo as a Windows Desktop Background.

TouchCopy can copy photos which were saved to your device using iTunes as well as photos which were taken by the iPhone camera.

Browsing and Viewing Your Photos

To view the photos on your iPod or iOS device click the "Photos" button in the category list.

The Photos viewer includes a control bar:

- TouchCopy lists all your photo Albums (folders), Events and Faces on a list on the left. Clicking on one of these items will display all the photos contained within that item.

To view a large version of an image:

- Double click the photo entry in the photo list.
- Click the "View Photos" button on the Photo tool bar.

To return to the thumbnail views, click the "Close" button at the bottom of the window.

Saving Photos to your Computer

Select an Album, Event or selection of photos and then copy them to your computer hard drive by clicking "Copy Photos" button in the TouchCopy photos tool bar. Alternatively, click "Copy to PC" in the main TouchCopy control bar.

TouchCopy will copy the selected photos to your save location specified in TouchCopy options. The photos will be copied into a sub-folder called "Photos". By default the save location is a folder called "iPod Content" on your Desktop.

Setting Pictures as your Desktop Wallpaper

Select one photo to copy to your Desktop - click the "Desktop background..." button on the Photo tool bar. TouchCopy will ask you how you would like to size the picture to your desktop. Make a selection and then click "OK".
Camera

To view Photos and Videos taken with your iPod or iOS device camera, click the "Camera" icon in the TouchCopy Categories list.

TouchCopy displays your photos and videos in groups. Items are grouped by type and by date. Selecting a group from the list on the left displays all the photos and/or videos in that group.

Copying Camera Items

To copy all items in the current view, do not select any photos or videos and then click either "Copy..." in the Camera browser tool bar or "Copy to PC" in TouchCopy's main control bar.

To copy a selection of items, make the selection of photos or videos and then click "Copy..." or "Copy to PC".

Viewing Camera Items

To view photos and videos taken by your devices camera, double click the items in the list or select the item and click "View" in the camera browser tool bar. TouchCopy will display the selected item, full size, in the view window.
Apps

With TouchCopy, you can view and copy Apps on your iOS device.

Notes that TouchCopy will only copy Apps on your iOS device that were purchased on the iTunes App Store. TouchCopy will not copy first party Apps installed by default on your device. (e.g. the Stocks and Calendar Apps).

To view Apps on your iOS devices, select the "Apps" icon in the category list.

Copying Apps to iTunes

To copy all your Apps back to iTunes, ensure no Apps are selected and then click "Copy To iTunes" in the Apps control bar or "Copy to iTunes" in the main TouchCopy control bar.

To copy only a selection of Apps, select the Apps required from the list and then click "Copy to iTunes" in either the Apps or TouchCopy control bar.
Application Documents

Each App in your iOS device has its own documents folder. Normally, this documents folder is visible only to the App itself. However, using TouchCopy, you can browse the contents of the Apps documents folder and copy, add or remove documents.

Select one App from the list and ensure the Documents panel is visible by clicking the "Details/Documents" button. A list of documents and folders will be shown for the App you have selected. Double clicking a folder in this list shows documents in that folder. You can go back to the previous folder by clicking the Navigate Back button.

Select a document from the list and click "Save to..." to save the file to your PC. Click "Delete" to permanently remove the document from your iOS device.

You can also add files to the Apps documents area by clicking "Add File...". Depending on the functionality of the application you are adding files to, you may or may not be able to see the files you are adding.
Books

Books fu nationality is available only for iOS devices that have the iBooks application installed.

With TouchCopy you can copy books from your iBooks App either to your PC or straight into iTunes. TouchCopy can handle both PDF and EPUB formatted eBooks.

To view the books on your iOS device, click the "Books" icon in the category list.

TouchCopy will display all the books on your iOS device and indicate the format that each book has.

Copying Books to iTunes

If no books are selected, clicking "Copy To iTunes" in either the book viewer tool bar or the main TouchCopy control bar will copy all of the books listed into your iTunes library.

Selecting a book or books in the list and clicking "Copy To iTunes" will copy only those selected books to iTunes.

Viewing PDF Files
This functionality requires PDF reading software to be installed on your computer. Such as Adobe PDF Reader.

Select a PDF formatted book from the list and click "View PDF". You can also double click a PDF book from the list to view it. TouchCopy will open the PDF Book in the default PDF viewer installed on your computer.
Call Logs

TouchCopy allows you to browse and copy any Call Logs you on your iPhone, iPad or iPod Touch. To view all Call Logs stored on your device, click the Call Logs button in TouchCopy.

Call Logs record telephone conversations and FaceTime conversation (iOS 6 upwards).

Displaying and Browsing Call Logs

TouchCopy displays a list of contacts or numbers who have called you or been called by you. Clicking on a name/number in the list displays the Call Log pertaining that person.

TouchCopy will display information such as the date each call was made and the contact name or number, if this call was missed or unanswered, and how long the call lasted.

Extracting Call Logs

Select which call logs you wish to extract by selecting one or more entries on the display list, then press “Extract Call Logs...” in the Call Log browser. TouchCopy will then ask you where you want the data saved, and an HTML file containing the Call
Log data will be created. If no entry is selected, the entire collection of Call Logs will be copied.
Contacts

To view contacts on your iPod or iOS based device, click "Contacts" in the TouchCopy category list.

TouchCopy contains an iPod Contacts manager that allows you to Add, Copy, View, Modify and Delete Contacts that are viewable directly on your iPod. TouchCopy provides a complete Contact Manager solution for standard click-wheel iPods.

For iOS devices, TouchCopy enables you to save your contacts from your device to your PC or Mac. On the PC you can copy contacts directly to your Windows Contacts or Microsoft Outlook. The instructions below also provide details on how to transfer contacts copied by TouchCopy to another iOS device.

Copying your iPod and iOS device Contacts (Exporting vCards)

In TouchCopy, press the Contacts button in the top control panel. This will display the contacts stored on your device.

TouchCopy has the ability to export your contact information of your iPod or iOS device into vCard format so that you can put your contacts into other programs. vCards are files that contain contact information about a person or company that can be understood by just about any Address Book or E-Mail program available. For example, vCards can be generated or imported into Windows Address Book, Outlook Express, Yahoo address book etc.

To copy your device contacts, select one or more contacts from the list of contacts in TouchCopy and click the "Copy as vCard" button. To select all your iPod Contacts, use the Ctrl+A key combination. Then simply select the folder you want to save your vCards into. TouchCopy enables you to create a separate Contacts folder to save your contacts to.

Importing saved vCards to another iOS device

Once you copied your contacts as vCards using TouchCopy, you can use your email or your address book program to import these vCards. If you are using Microsoft Outlook, open the folder where your contacts were copied and select them all using the Ctrl+A key combination, and drag and drop them to Contacts in Outlook. Outlook will open each contact and then click on Save and Close button to save each contact to your Outlook Contacts.

You can then use iTunes to sync Contacts you imported to Outlook or another address book program to another iOS device. Connect your other iOS device to your computer, open iTunes and chose your device under DEVICES in iTunes. Click on the Info tab in iTunes and check "Sync Contacts", chose your address book program and click on the "Sync" button.

Copying Contacts to Windows Contacts

This functionality is only available for Windows 7 and Windows Vista.
To copy contacts directly to your Contacts folder in Windows 7 or Windows Vista, select the contacts required and click, "Copy to Window Contacts". TouchCopy will export the selected contacts to your Windows Contacts.

**Copying Contacts to Microsoft Outlook**

To copy contacts directly to your Microsoft Outlook contacts manager, select the required and click, "Copy to Outlook".

**Exporting vCards**

TouchCopy has the ability to export your contact information of your iPod into vCard format so that you can put your contacts into other programs. To do this, select one or more contacts from the list of contacts in Contact Manager and click the "Export vCard" button. To select all your iPod Contacts, use the Ctrl+A key combination. Then simply select the folder you want to save your vCards into.
Calendars

TouchCopy allows you to view, copy, manage and add appointments to your Calendars stored on your iPod. TouchCopy provides a complete mobile calendaring solution for standard click-wheel iPods.

For iOS devices, TouchCopy enables you to save your calendars from your device to your PC or Mac. The instructions below also provide details on how to transfer calendars copied by TouchCopy to another iOS device using iTunes.

To view calendars in TouchCopy, click the "Calendars" icon in the category list.

Copying your iPod and iOS device Calendars to your Computer

In TouchCopy, press the Calendar button in the top control panel. This will display the calendars stored on your device. To return to the music listings, press the Calendar button again or press the Back to Music button. You can toggle between the music listings and viewing calendars by pressing the Calendar button - even while copying or playing music.

You can copy all your calendars by clicking on "Copy Calendar" button in TouchCopy without selecting any individual calendar entries.

To copy individual calendars, click on the calendar you wish to copy and click on "Copy Calendar" in TouchCopy.

You can also copy individual events in your device calendar by right-clicking on an event and choosing "Save as iCal file".

By default your calendars will be saved as iCal files to your desktop. You can change the save location for your calendars in TouchCopy.

Importing saved iCal files to another iOS device

Double-clicking on the iCal files saved by TouchCopy will automatically import them to your usual calendar manager such as Outlook. You can then use iTunes to sync these iCal files to another iOS device. Connect your iOS device to your computer, open iTunes and chose your device under DEVICES in iTunes. Click on the Info tab in iTunes and check "Sync Calendars" with Outlook, and click on the "Sync" button.
File Manager for iOS based devices.

This functionality is only available for iOS based devices. e.g. iPod Touch, iPhone or iPad.

To view the files and folders on your iOS based device click the "Files" icon in the categories list.

Copying Files from your Computer to your iPod Touch or iPhone

You can drag and drop files or folders from your computer into TouchCopy to add those items to your iPhone or iPod Touch.

Also, the Files toolbar provides additional functionality...

The following buttons enable you to write new files and folders to your iPod Touch or iPhone:
"Create Folder" button - click this to create a new folder or a sub-folder on your iPod. You can also create or delete folders on your iPod by right-clicking the folder.

"Add File" button - click this to select the file you wish to copy from your computer to your iPod. Then click on Open in the dialog box and the selected file will be copied to your iPod.

"Add Folder" button - click this to select a folder you wish to copy from your computer to your iPod. Then click on OK in the dialog box and the selected folder will be copied to your iPod.

Note that you can only view any files or folders that you have added to your iPod Touch or iPhone when your device is connected to your computer.

Finally you can delete selected files or folders on your iPod by clicking the "Delete Selection" button.

**Copying Files from your iPod Touch or iPhone to your Computer**

The simplest way to copy the content of the selected folder on your iPod Touch or iPhone to your computer is to click on the "Copy to PC" or the "Copy to Mac" button on your TouchCopy control bar. This will copy the selected files and folders to a location on your PC as given by your TouchCopy options. By default, this is "iPod Content/Files" on your desktop.

Alternatively you can select files or folders you wish to copy from your iPod to your PC and click on "Copy Selection to PC" button. Then choose the location on your computer where you wish to save your files and click OK.

Also, double clicking on a file within TouchCopy will allow you to copy that file to your PC having selected the folder you wish to save that file to.

**Browsing System Files - Or Not.**

By default, TouchCopy will show you all your files and folders on your iPhone or iPod Touch media directory. You can browse, copy, add or delete any files or folders in this directory. Be careful not to delete any system files placed there by iTunes! TouchCopy will warn you if you try to do so.

You can use TouchCopy for PC in another mode where all your own files and folders are stored in their own location, away from your media and system files. To switch to this mode, open TouchCopy options and select the "File browser" tab. Uncheck the box "Browse System Files".

Internet

TouchCopy allows you to browse through your iOS device's Internet History and Bookmarks, and allows you to save these pages as links or to open them on your preferred browser.

To view the Internet data stored on your iOS device, click the Internet button in TouchCopy.

Displaying and Browsing your Internet Data

TouchCopy displays the internet Bookmarks stored on your iDevice, as well as Safari's browsing History. Clicking on a website in the list displays the website on the right side of the window, if there is an internet connection.

You can switch between Bookmarks and History by clicking the tabs with the same name over the list. There is also a "Search Bookmarks" tab which provides you with a quicker method to find specific websites within your Bookmarks.
Saving and Opening websites

Select which website you want to access; you can now click on "Save as Shortcut" and select a destination to create a link file (.url) to the website you have selected. Alternatively, you can press "Open in System Browser" to open it on your operating system's preferred web browser (such as internet explorer, mozilla firefox, google chrome, safari, etc).
Messages

To view SMS, MMS and iMessage content on your iOS device, click the Messages icon in the category list in TouchCopy.

TouchCopy displays a list of contacts with whom you have had SMS conversations. Clicking on the contact in the list shows the text (SMS), multimedia (MMS) messages and iMessage sent and received in that conversation.

With a contact selected and a conversation displayed, click "Copy to PC" or "Copy to Mac" in the TouchCopy control bar to save that conversation to your computer.

TouchCopy will copy the SMS conversation into a .html file, which is saved by default on your computer desktop in the iPod Content folder under a sub-folder titled message. You can change the location where your conversation is stored by using TouchCopy options.

Each .html file containing the conversations is named after the individual contact with whom you had the conversations. You can open this .html file using a browser such as Firefox or Internet Explorer.
If your conversations also contain images or pictures (MMS), TouchCopy will also copy these to your computer and embed them in the .html file saved.
Notes

The Notes editor allows you to view and export notes on your iPod, iPhone or iPad to your computer.

Opening the Note Editor

To view the notes available on your iPod or iOS device, click "Notes" in the TouchCopy categories list.

In TouchCopy, press the Note button in the top control panel. This will display the Note editor. To return to the music listings, press the Note button again or press the Back To Music button. You can toggle between the music listings and the Note editor by pressing the Note button - even while copying or playing music.

Save the selected Note/Notes from your iDevice to your computer by clicking
Voice Memos

This functionality is only available for those iPods and iPhones that support voice memo recording.

If your iPod or iPhone support the recording of Voice Memos (or Voice Notes), TouchCopy can play and copy those recordings on your device.

If TouchCopy detects that your iPod contains Voice Memos, the TouchCopy source list will display the categories of voice memos present under the "Voice Memos" heading.

Clicking on one of the Voice Memo categories (such as None, Idea, Lecture etc.) will display all the voice memos made under that category. To show all the voice memos on your device, shift click all of the categories show in the source list.

Once your required voice memos are listed in TouchCopy you can use them just like any other audio file in TouchCopy.

Play

Select the Voice Memo you wish to listen to through your PC or Mac and click the play button in the TouchCopy control bar.

Copy

Select the voice memo you wish to copy to your computer and click the "Copy to PC" or "Copy to Mac" button in the TouchCopy control bar. TouchCopy will copy your voice memos to a location on your hard drive selected by your TouchCopy options, by default this is your computer desktop. TouchCopy also produces an XML file named after the voice memo category you are copying (by default this is None). This XML file can be used to import the voice memos into iTunes as a playlist.
Transfer to iTunes

Select the voice memos you wish to transfer to iTunes and click the "Copy to iTunes" button in the TouchCopy control bar. TouchCopy will copy your voice memos into iTunes as a playlist, named after the category of voice memos you have chosen to copy, by default this is None. Alternative labels include Interview, Lecture, Memo, Idea, Podcast or any other category label you may have chosen on your iPhone.